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Preface

The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the
latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation
folder available on your network from which you can access the Oracle|Agile documentation (PDF)
files.

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals
in both the Agile Web Client and the Agile Java Client. If you need additional assistance or
information, please contact support http://www.oracle.com/agile/support.html
(http://www.oracle.com/agile/support.html) for assistance.

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please
have the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible, with good
usability, to the disabled community. To that end, our documentation includes features that make
information available to users of assistive technology. This documentation is available in HTML
format, and contains markup to facilitate access by the disabled community. Accessibility standards
will continue to evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be accessible to
all of our customers. For more information, visit the Oracle Accessibility Program Web site at
http://globaldc.oracle.com/perl/twiki/view/AccessibilityProgram/WebHome http://www..

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html



http://www.oracle.com/technology/documentation/agile.html
http://www.adobe.com/
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/agile/support.html
http://globaldc.oracle.com/perl/twiki/view/AccessibilityProgram/WebHome
http://www./
http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Introduction to Agile PG&C

This chapter includes the following:

= About Agile Product Governance & COMPIIANCE .........ccvrerreerricerieessesess s s ssssssssssessssees 1
= How PG&C Gathers and Manages COmMpPlIanCe DAt ........cco.vevrinrieeninirenieisersene st sessssssesesssees 2
= Agile PLM Documentation fOr PGEC ..ottt eses s 3
= MiICroSOft EXCEIFDASEA CHENE .........cvveieriiiicecesi s 3

About Agile Product Governance & Compliance

Agile Product Governance & Compliance (PG&C) is designed to help manufacturers audit the
presence and amount of regulated substances used in their products, and to demonstrate that they
responsibly dispose of, recycle, or re-use parts containing those substances.

This figure depicts a standard cycle of procurement and manufacturing. Other Agile solutions —
Product Quality Management, Product Cost Management, Product Portfolio Management, Product
Collaboration — manage areas around the lower half of the cycle. Product Governance and
Compliance manages the compliance data-gathering area.
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Figure 1-1: Closed-Loop Compliance—Corrective Action Process
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OEM manufacturers are required to take global responsibility to dispose of, recycle, or re-use
electronics that contain hazardous substances. In addition to satisfying FDA regulations and ISO
standards, any company that sells electronics equipment in an international market is subject to the
OEM manufacturing regulations of their target markets.

How PG&C Gathers and Manages Compliance Data

Agile PG&C is a communication vehicle between the compliance manager and suppliers. People
who manage the compliance process at the “buyer” site — compliance managers — must ensure that
their company’s products adhere to government regulations and company policy.

More specifically, compliance managers use PG&C to:

o Collect data about materials used to manufacture a product

= Analyze those data to determine compliance with re-use, recycling, and restriction targets

o Collect compliance information on the various regulations (part-level compliance information)

@ Collect manufacturing process information on parts

Page - 2 Agile Product Lifecycle Management
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o Generate reports to show the level of compliance

= Manage supporting documentation, such as descriptions of current regulations, recovery
manifests, disposal certificates of destruction, supplier compliance surveys, and other
customer-specific specifications.

Agile PLM Documentation for PG&C

The Preface of this manual provides the URL to Agile documentation for current releases of Agile
PLM.

This manual, Agile PG&C Supplier Guide, provides information for you to learn to work in Agile Web
Client and to complete your end of the compliance process.

A supplier in the PG&C solution is a company that provides compliance information about parts that
are used in a buyer company’s manufacturing process. The Agile administrator at the buyer
company has created Agile users, which have been called "contact users" and are now referred to
as "declaration recipients” in the PG&C framework.

The compliance manager at the buyer company creates declarations that are sent to the supplier’s
declaration recipients. In turn, declaration recipients complete declaration requests from the buyer.

The chapters and main topics in this manual are:

B RFI Process and Agile Classes (on page 5):

® Requests For Information (on page 5)
® PG&C Business Objects (on page 6)

o Using Agile Web Client (on page 9):

® Introducing Agile Web Client (on page 9)
® Changing Your User Profile (on page 12)

B Responding to Agile Compliance RFIs (on page 15):

®  Filling Out a Declaration (on page 16)
* About Declaration Classes and Fields (on page 18)

* Importing and Exporting Declarations (on page 24)

®*  Working with Microsoft Excel-based Client (on page 27)

PG&C User Guide

The Agile PG&C User Guide is the manual for working in the PG&C solution on the buyer side. It
describes the PG&C-specific business classes in depth, as well as compliance rollups and other
features. In some cases, the manager of Agile-based compliance work at your firm might find value
referring to the User Guide.

Microsoft Excel-based Client

You may want to complete declaration requests entirely within the Agile environment, as described
in this manual. It is also possible to complete declarations in other environments by exporting data
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from and importing data to Agile. Also, a Microsoft Excel-based Client is another means of
simplified compliance fulfillment.

If your company has been configured to use this client, you will need to access it via Agile Web
Client the first time.

Note Some companies do not permit their employees to download ActiveX controls
to their desktop computers. Therefore, the Microsoft Excel-based Client may
have to be implemented by the IT department of your company via a “push
approach”: this automatically pushes the ActiveX control out to users’ desktops.
In any case, you may need to work with your IT department to integrate the
Excel-based Client.

The Microsoft Excel-based Client functionality allows you to open companion spreadsheets in
Microsoft Excel, connect to an Agile PLM system, download information, fill out required
information, run local validations and calculations, and upload the information directly into Agile
PG&C.

@ Use Case 1: Using the JGPSSI spreadsheet template, upload information to Agile PG&C after
validation.

@ Use Case 2: Using the Agile Excel Integration Framework, you can create Excel-based
integration for any of the declarations; contact your Agile representative.

Minimum Requirements for Microsoft Excel-based Client

Microsoft Excel-based clients for Agile PG&C require the following client-side software. These
requirements have likely been satisfied by the time you are called on to fulfill Agile declarations.

Operating System
5 Windows 2000 Pro SPX or Windows XP Pro SP2

Client Applications
8 Microsoft Excel 2000, Microsoft Excel XP, or Microsoft Excel 2003

o Microsoft Internet Explorer 5.5 or 6.0

Page - 4 Agile Product Lifecycle Management
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RFI Process and Agile Classes

This chapter includes the following:

= ReQUESES FOT INFOMMALION ...vvvceciicieisice et s s 5
B PGEC BUSINESS ODJECES .....vuivuiiisieiieiseireieesetsese bbb bbb bbb 6

As an information provider (“supplier”) to a manufacturer (“buyer”) who is seeking compliance
information via Agile PG&C, this manual is your user handbook.

Your company may or may not actually manufacture specific parts that go into the products of an
OEM; in any case, your company does provide compliance information about parts to this
manufacturer.

Requests For Information

At the supplier site, information providers use PG&C to complete and sign off on Declarations — the
vehicle of Requests For Information (RFIs):

= Declare compliance with specifications concerning hazardous materials;

= Disclose which hazardous substances are contained in the components and subassemblies it
provides or is authorized to provide data or other disclosure information.

A declaration keeps track of the compliance information about substances and materials contained
in parts or part groups that are named in the declaration. The Default Declaration Workflow conveys
RFIs from your buyers. Agile PLM Release 9.2.2 also makes it possible to send customized
Declaration workflows to suppliers.

RFI Sequence

The general sequence of the RFI process follows. The supplier is involved in step 5 only; the other
steps take place at the buyer company.

1. Identify parts and part groups for which compliance data is required.

2. ldentify people within buyer company and suppliers (for manufacturer parts) who can provide
compliance data.

Create declarations for parts, manufacturer parts, and part groups.
Route a declaration to an information supplier.
Supplier completes the declaration with data and a signoff.

Compliance data is assessed for completeness and validated for correctness.

N o g s~ w

Reviewed and approved declarations are released, which “publishes” the data across the
product record in PLM.

Agile Product Lifecycle Management Page -5
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The RFI process is depicted in the graphic below.

agile The Agile PG&C RFI Process
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PG&C Business Objects

The PG&C solution offers configurable business objects called Substances, Specifications,
Declarations, and Part Groups. Iltems and Manufacturer Parts (from Agile Product Collaboration)
are also integral to the solution.

Note It is possible that your buyer’s Agile administrator has renamed existing classes
and created new subclasses than those presented in this guide.

Here are brief definitions of the PG&C business objects.

Substances

Substances are basic building blocks in PG&C. A substance is any chemical element or compound
that is tracked within Agile PLM. There are four kinds of substances, which cover a variety of
circumstances: Substances, Substance Groups, Materials, and Subparts.

B Subparts class — a subpart is a subunit of a component. Subparts are not numbered and do not
expand the BOM.

o Materials class — a material is a compound chemical, that is, a substance consisting of multiple
substances. A good example of a material is a glue or a resin that can be bought in bulk.

o Substance Groups class — a group of multiple substances. A substance group must have a Base
Substance, which is the substance that the legislation is interested in. A substance group called
“Lead and Lead Compounds” would cite Lead as its base substance, and it could comprise
chemicals like Lead-oxide, Lead-nitrate, and Lead-sulfate.

o Substances class — a substance is a single chemical element; for example, lead, chromium, or
cadmium. Generally, these are the potentially hazardous substances that legislations are
interested in, as described in specifications. The new Alias attribute facilitates possible
inconsistencies in how substances are named by the supplier.

Page - 6 Agile Product Lifecycle Management
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Substance Aliasing

The Alias attribute is provided to inform the PG&C system of “substitute names” of substances and
substance groups. For example, an alias for Lead could be the chemical notation “Pb”. The buyer’'s
system can then resolve confusion if you, the supplier, submit information for a substance that you
call Pb but they call Lead.

If the name of a substance/substance group that you provide (in the declaration) does not exist in
the buyer’s system (and it is not already an alias for another substance), the buyer can add it as an
alias for the intended substance/SG.

This makes it easier for you to use names of substances and substance groups in your declaration
responses according to your conventions without concern that a name may be different in the
buyer’s system.

Specifications

Specifications track the different legislations, customer specifications, or internal specifications with
which an assembly or part must comply. The Specifications object is used to create representations
of specification documents, regulations, published compliance criteria.

An example of a regulation issued by a government body is the European RoHS directive.
Environmental specifications are substance-based, and contain a list of banned substances or
substances of concern and their threshold values.

In Agile, specifications are used to validate declarations and assess the compliance of parts by
evaluating whether a given restricted substance in the composition of a part surpasses its specified
threshold value.

Parts and Part Groups

Items and Manufacturer Parts can be referred to generally as “parts.” The phrase “parts and part
groups” (or the notation <Part/PG>) comprises “any kind of part used in the buyer company’s
manufacturing process.”

Items and Manufacturer Parts

Items (Parts and Documents) and Manufacturer Parts — we refer to these collectively as “parts” — are
two base classes in Agile PLM that are used to create objects that represent the things that your
company and its suppliers assemble into the products your company sells. They are therefore the
entities for which compliance data must be sought.

Part Groups

A part group (PG) is a “container” that tracks the overall chemical composition for all parts of a
particular type. If multiple parts share the same properties — for example, the same composition —
you can define a part group with those characteristics. The parts (items and manufacturer parts)
belonging to a part group have a conversion factor that is used to convert data such as Mass and
Substances Content from the part group to its member parts.

To describe how the conversion factor works, let a part group describe a series of cable, made of
the same materials and available from supplier(s) in a variety of lengths. The part group (the Agile
object) contains the data that defines the “unit” length of cable to be 2 feet long. The part group
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object then lists cables of 2 ft, 6 ft, and 10 ft in length. So, the 2-ft cable has a conversion factor of 1
in terms of its mass and hazardous substances content, the 6-ft cable has a conversion factor of 3,
while the 10-ft cable has a conversion factor of 5.

Declarations

A declaration is the main object of record in the PG&C solution: it stores questions posed by a
compliance manager to an information supplier about the supplier itself, its products, or how its
products comply with given specifications. Upon completion, it contains the supplier’s data and
responses to the questions. Also, declarations keep track of all the substances and materials that
are contained in parts or part groups.

PLM 9.2.2 offers an attribute called User-entered CAS Number, which can be entered by the
information supplier on a declaration or by a regular user on a part or part group. These are used by
the compliance manager to ascertain precisely what substance is being referred to by the supplier.

In Agile PLM, the Declarations base class has seven default classes of declarations, each with a
single child subclass. The following table defines the kinds of declarations in PG&C.

Table 2-1: Declarations classes

Declaration class Definition

Substance The supplier is requested to provide compliance information for each substance within

Declarations

the specifica

Homogeneous
Material
Declarations

The supplier is requested to provide a complete BOS breakdown of the part and
provide compliance information at the homogeneous material level.

Part Declarations

Receive part-level compliance information as well as other composition header level
information (manufacturing parameters).

JGPSSI Declarations

The supplier is requested to provide compliance information (weights) according to
the JGP stan

Note: There is a fully supported Japanese version of the JGPSSI template for creating
JGPSSI Declasee your administrator.

Supplier A questionnaire to assess supplier compliance with specifications from customers and
Declarations of government agencies. The survey addresses compliance at a general company level.
Conformance Can be used for CSR type dec

IPC 1752-1 A Joint Industry Guide (JIG) substance declaration for electronic products.
Declarations

IPC 1752-2 A Joint Industry Guide (JIG) homogeneous-material declaration for electronic

Declarations

products.

Declarations are the routable objects in PG&C, similar to change orders in Product Collaboration.
As a routable object, each declaration advances through a workflow that implements the Request
for Information (RFI) business process. When a declaration is released by the compliance manager,
the information gathered from it is published to the product record, thereby updating the
composition data contained within the parts and part groups listed by the declaration.

Page - 8 Agile Product Lifecycle Management
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Using Agile Web Client

This chapter includes the following:

= Introducing AGle WED ClIENT .......c.ovieeecces e 9
= Changing Your USEE PrOfilE ..ot 12

Introducing Agile Web Client

Agile Web Client is opened using only a browser. Web Client is the only client that supports Agile’s
Product Governance & Compliance solution (PG&C). As a supplier, you are generally assigned to
“Basic mode,” and your user interface with Web Client has been streamlined for responding to
PG&C declaration requests.

If your work becomes more involved and the buyer firm assigns you one of the “Advanced modes,”
you will see the full user interface of Web Client; in that case you will refer to the standard solution
manual, PG&C User Guide.

Logging In to Web Client

Your buyer company’s compliance manager has issued you a starting URL, along with username
(User ID) and password. If a URL is specified in the documentation or release notes, copy the
upper- and lower-case characters exactly, including the full domain name specified.

To start Web Client:

1. Start your browser.

2. Click the Web Client bookmark, if one exists, or type a URL that follows this pattern:
http:// <web-server>.<domain-name>.com/Agile/PLMServlet
The Login page appears.

3. Enter your username. Your username is not case-sensitive.

Your username is assigned by your Agile compliance manager; it is likely an abbreviation of
your full name. For example, the name Michael Jones may be abbreviated to MICHAELJ or
MJONES.

Enter your password. Your password is case-sensitive.

Click the Login button. If you make a mistake, click Clear and retype your username and
password.

The login process is complete, and the Requests for Information page appears. In the page’s title
bar you will see “Welcome, <Your Name>".

The page is on the Open Requests link, so the table will list any Agile “declaration requests” that have

Agile Product Lifecycle Management Page - 9
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been sent to you. The other links are described in Left Pane Links (on page 11).

Figure 3-1: Agile Web Client (Basic mode) for PG&C supplier

7 http:/ /jpw2k3-gx300.agile.agilesoft.com - Agile Product Lifec

My Profile  Helpw  Logout

Requests for Information

¢ To respond to a Request for Information, click the link in the Action columnn or click the Number link to open the Request,
Open Requests Q Find  Show All
Due Today Selectedi 0 of 1 M 4Pagei[L | af1h M
Due Tomarrow | Hurnber ‘ Action ‘ 1] | Description Status Requested ‘ Completed | Dus Date
Delinguent MDO00as Export AXML.. i Open To E i] 04/12/2006

Supplier 12:00:00 &M

Inactive Requests POT

Rows per page: |50 |x M 4page: [t x| of1h M

Main Toolbar

You can use the toolbar buttons on the main toolbar to perform the tasks described in the following
table.

Button Name Description

Back Takes you to the previous page you viewed in your browser. (It does not,
however, undo any changes you entered in Agile.)

Forward Takes you to the next page forward. It is disabled if you have not gone forward
from the page currently in your browser.

ﬁ Refresh You can refresh (update) the information on the visible page.

1",}, Home Brings you back to the basic RFI page.

Notifications Clicking the link displays a list of your received notifications, alerting you to

events in the RFI process.

My Profile Clicking the link displays the information that defines your “user object,” which
governs your access to Agile declarations. You can click Edit and change any
of the editable fields. Click Save to save these changes or click Cancel to end
the operation without changing your profile.

For more information about changing the fields and definitions of the user
properties, see Changing Your User Profile (on page 12).

Help The Help > About Agile command displays version information.

LogOut Lets you exit Web Client.
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Button Name Description
Q, Find Find (Run Searches for declarations that match your typed input. For example, if you are

Simple Search) | in Open Requests and there are many, you can search and find the one you
are looking for.

Logging Out of Web Client

To log out of Web Client:
1. From the menu bar, click the Logout button.

2. You are returned to the Login page. To exit, close the browser from the upper-right corner.

Printing Declarations

From the Basic Supplier Interface, the system will print the following tabs of a declaration: Cover
Page; PageTwo; PageThree; Parts/Part Groups tabs as well as the corresponding Substances tables; and
Specifications.

Left Pane Links

The left pane on the main RFI page has links as follows:

*  Open Requests — this is the default link so you generally see a list of all your open
declaration requests. If you have clicked another link, Open Requests appears as a live
link.

* Due Today — lists all open declarations whose due date is set for the current calendar day.
*  Due Tomorrow — lists all open declarations whose due date is set for the next calendar day.

* Delinquent — lists all open declarations whose due date is set for the previous calendar day
or earlier.

* Inactive Requests — lists all declarations that were submitted to you but that have been
closed by your buyer.

Open Declaration Links

When you have opened a declaration request, the left pane changes its links to the following:

* Edit — Click this link to activate editable fields. Change or add values in any of those fields.
Click Save to preserve your changes, or clicke Cancel to end the operation with no changes
saved.

*  Add Attachments or View Attachments — Click this link to add attachments to the declaration
(for example, you may want to return a spreadsheet file to the buyer). If the declaration
already has attachments, the link says View Attachments, but you can still add attachments
by clicking and following the user interface.

®  Submit Declaration — When you have completed providing the requested data on the
declaration—and signed off— clicking this link will send it back to the compliance manager at
the buyer firm.

*  Print — You may wish to have or distribute a hardcopy of the declaration at the start or
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when it is completed. Click this link to bring up a Print dialog.

* Email Comments — You may have a question for the compliance manager or other
information that you want to quickly distribute. When you click this link, there are two
elements to complete. In the Comments field, simply type your message or question. Click
the Send To button to start a wizard to find names.

When you are ready, click Send to send the comments. Click Cancel to end the operation
with no email sent.

Using the Process Extensions

Note that following the actions listed above, other applicable process extensions are displayed. This
topic is covered in Importing and Exporting Declarations (on page 24).

Changing Your User Profile

Your User Profile is simply the collection of settings that were entered by the Agile administrator
when your “user object” was created. Clicking the link in the main toolbar displays the information
contained in your profile, some of which is simply information (like phone number) and some of
which governs your access to Agile declarations (like Role).

Your user profile is available for you to modify, within constraints set by the administrator. It
contains data under two tabs, General Info or Preferences.

Important Under Preferences, the Response Edit Mode property is set to Basic and should be
left on that setting.

If you select one of the other two settings, Advanced Table Edit or Advanced Wizard Edit, when
you click Save, you will be prompted to log out and log back in; you would then log in to
Web Client (Advanced mode), where your capabilities are restricted.

If you do log in to Web Client (Advanced mode), you will have to click the My User Profile
link and go to Response Edit Mode property to change it back to Basic, followed by logging
out and logging back in to Web Client (Basic mode).

If you work frequently with buyer companies and are often required to create declarations,
you can be assigned additional roles and privileges to enable you to work effectively in
Web Client (Advanced mode).

You have an opportunity to enter information when you first log in to Web Client. Again, your Agile
administrator determines to what extent you can edit your user profile.

To edit or add information to your user profile:
1. Open your user profile by clicking My Profile.

2. Click the tab on which you want to make changes. For instance, to make changes to the
General Info tab, click that tab.

3. Click the Edit button on that page. Use lists, browse buttons, and text boxes to enter the
requested information.

4.  When you have finished, click Save. If you wish to cancel your changes, click Cancel. Clicking
the other tab (General Info or Preferences) will also cancel the current Edit operation without
saving changes.
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5. To verify changes you make to your user profile, it is best to log out of Web Client and log back
in.

Note If you will be working primarily in Web Client, check this setting in your user
profile: Preferences > System Preferences > Preferred Client; it should be set to Web
Client. Also, Receive Email Notifications should be sent to Yes. This will ensure
that you will receive email naotifications in the same client you are working in. If
there is a discrepancy and you are not able to change these properties, see
your Agile administrator.

User Properties Defined

Table 3-2 lists and describes the properties common to supplier users in the Agile PLM system.

Table 3-2: User properties

Property Description

General Info tab

User ID (username) The user’s Agile PLM login user identification, or username. It must be unique in the
Agile PLM address book. The maximum is 128 characters.

First Name and Last The user’s public name. Neither of the user's Names fields has to be unique in the

Name system, only the user’s User ID must be unique.

Status Indicates whether the user is enabled (Active) or disabled (Inactive). Not editable.

Email The user’s valid email address for change notification/routing. Note: If there is not a
valid email address in the Email field, the user will not receive any email notifications.

Title The user’s title, for example, Senior Engineer.

Address fields There are four address fields that are used for informational purposes only: Address
(street), City, and Postal/Zip Code.

Phone number fields The user's Business Phone and Mobile Phone numbers (for informational purposes
only).

Fax The user’s fax number (for informational purposes only).

Pager The user’s pager number (for informational purposes only).

Secondary Email The user’s valid email address for change notification/routing. The Secondary Email is
optional, but when the field is filled in, the user receives notifications at both email
addresses.

Table 3-3: User properties

Property Description

General Info tab, continued

Role(s) The user’s role assignments. This property determines a user’s access to the objects in
Agile PLM from the point of discovery forward.
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Property Description

User Category Power, Concurrent, or Restricted: you as a supplier are a Restricted user.

Use Login Password Each user has a login password and approval password (used to approve changes).

for

Approval

Allow Escalation This setting is editable. If the user has identified one or more designated escalation

Designation Approval persons (DEPS), this setting determines when the DEPs can approve or reject a
declaration.
Settings:
After Escalation — The user's DEP can approve a routable object only after it has been
escalated.
Always - The user's DEP can always approve or reject a routable object.

Sites Sites are used for distributed manufacturing, but as sites are not supported by PG&C,
this is unlikely to have options.

Authorized Ship-To Authorized Ship-To is used only by PCM.

Preferences tab

Preferred File Manager | Select from the list of file servers. For best performance, select a file server that is local
server for you.

Receive Email Controls whether the user can receive automatically generated email notifications from
Notification the system.
Settings = Yes or No

Language English is available with all Agile PLM licenses. Agile PLM includes Japanese or
Simplified Chinese, per your license. Other languages will be made available in the
future.

Preferred Date Format The format in which dates are displayed to the user. Default is MM/dd/yyyy.

Time Zone The time zone where the user is located.

Preferred Time Format The format in which times are displayed to the user. The default is hh:mm:ss aaa (aaa
=am or pm).

Preferred Currency The currency in which prices/costs are displayed to the user. The default is U.S. Dollar.

Number Format The format in which numbers are displayed to the user.

Preferred Inbox View Select between Activities, Notifications, and Workflow.

Response Edit Mode This field should be left set to Basic. The other two settings, Advanced Table Edit and

Advanced Wizard Edit, will take you into the main Web Client, where your capabilities
are restricted.

Rows per Table The number of rows that appear in the user's Agile Web Client user interface. The
Display default is 50.

Static Table Headers Set to Yes to carry table headers to additional pages.

Encode Type The types are Western European (ISO), Japanese (Shift JIS), Traditional Chinese (Big

5), Japanese (EUC), Simplified Chinese (GB2312), and Unicode (UTF-8).
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Responding to Agile Compliance RFIs

This chapter includes the following:

N 11T To O 101 W= - T o T 16
= About Declaration Classes and FIEIUS...........vurrrririrereesie et 18
B SUDSEANCE EIIING .. cvviveeieirireieisereirieei sttt 23
= Importing and EXPOrting DECIAIAtIONS............cuevririuriieirireieir ettt 24
= Working with Microsoft EXCEI-DASEA CHENL...........cccieuiicrie st 27

A Request For Information (RFI) is the process that a manufacturing company (the buyer) uses to
seek compliance data from its suppliers. The buyer uses Agile PG&C to create declarations. When
the buyer firm creates a declaration, it specifies a unique declaration name and a single supplier

company.

The Default Declarations workflow follows a straightforward process flow, as detailed in the

following table.

Table 4-1: Typical RFI Workflow

Status

Action

Pending

Compliance manager (an Agile user who has been assigned the Compliance
Manager role) crea new declaration, or modifies an existing declaration by adding
new items, manufacturer parts, or commodities. Specifications are added to the
declaration, and also an information supthere is always only one supplier per
declaration.

Open to Supplier

The declaration requests the supplier (an Agile user who has been assigned the
Material Provider role) to confirm whether parts comply with specifications.

Submit to Manager

Supplier confirms or denies that the parts that they supply comply with regulations.

The supplier electronically “signs” and submits the declaration back to the
compliance manager.

Review

The compliance manager and other reviewers verify and approve the contents of
the declaration.

Released

The compliance manager releases the declaration, thereby publishing the new data
about the substances and materials into the product record. Once published, the
materials are visible on the Compliance tab of the part or part group, as
appropriate.

The “buyer” company can now examine the quantities of all materials in a given
top-level assemand find out if the assembly is compliant with a set of specifications.

Implemented

Once the parts are manufactured and disseminated in the field, the compliance
manager implethe declaration, thereby completing the workflow.
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Filling Out a Declaration

To complete and sign off declarations, declaration recipients for the supplier company have been
assigned a role that permits access to the declarations. The default declaration recipient at the
supplier company receives an email of notification.

All users at the supplier company who have been assigned the appropriate role can respond to the
declaration.

If you have questions about who in your company has been assigned this role, contact your buyer
company.

When you are sent a declaration request, you are responsible for completing it. You must disclose
whether or not any restricted substances are contained in the component or subassembly it lists,
and whether those substances comply with the given specifications.

Once a declaration is opened to a supplier, only the supplier’'s declaration recipients can edit it (that
is, Agile users assigned the "(Restricted) Material Provider" role). For other users, including the
compliance manager, the declaration becomes "read-only" until it is returned by the supplier.

Notifications when Declarations Advance to and from Supplier

This set of default behaviors regards automatic naotifications, not user-designated Approvers and
Observers.

= Declaration Buyer to Supplier — The notification is automatically sent to the supplier. You can add
more users to receive notification.

o Declaration Supplier to Buyer — The compliance manager is automatically added to the notification
list. If no compliance manager was selected, the system add everyone on the Compliance
Managers notification list.

o Declaration Supplier to Buyer — If there are no compliance managers in the system, the originator
is added to the notification list.

Information Supplier Fills Out a Declaration

When a declaration request is opened to an information supplier, the supplier is responsible for
completing the declaration and disclosing if any restricted substances are contained in the
components and subassemblies it provides and whether those substances comply with
specifications.

To complete and sign off on declarations, one or more declaration recipients for the information
supplier must be assigned the (Restricted) Material Provider role. If you have questions about who
in your supply chain has been assigned this role, see your administrator.

When the material provider changes the status of the declaration from Open to Supplier to Submit to
Manager, he must “sign off” the declaration.
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Process Sequences in Declaration Fulfillment

The above describes a standard Agile declaration being to a supplier and, upon completion, being
returned to the buyer. The following process sequences describe a range of responses to
declarations.

Declaration Opened and Completed in Agile Web Client

1. Supplier firm’s default recipient receives email notification from buyer firm's Compliance
Manager requesting completion of a compliance declaration.

2. Click link within notification and log into Agile Web Client (Basic mode).
3. Click Open Requests link and select the particular declaration request.

4.  Fillin your responses directly in Web Client. Currently this is possible only for Supplier
Declarations of Conformance.

5. Complete the Signoff Message and submit response back to the Compliance Manager.

Declaration Opened in Web Client and Completed in Microsoft Excel-based Client

1. Supplier firm’s default recipient receives email naotification from buyer’'s Compliance Manager
to complete a compliance declaration.

2. Click link within notification and log into Agile Web Client (Basic mode).

3. Use the Open in Excel process extension. The declaration opens in (pre-installed) Microsoft
Excel-based Client, and the file is immediately saved to your hard drive in a folder called Agile
Spreadsheet Files.

4.  Within Microsoft Excel, enter your responses into the form, and save it.

5. On the Agile menu in the Excel client, choose Submit Response.

6. Complete the Signoff Message and click OK.

Declaration Opened and Completed in Microsoft Excel-based Client

1. On the Agile menu in the Microsoft Excel-based Client, select from list of open declarations.
The spreadsheet is populated with data from new declaration.

2. Within Microsoft Excel, enter your responses into the form, and save it.
3.  On the Agile menu in the Excel client, choose Submit Response.

4. Complete the Signoff Message and click OK.

Declaration Opened in Web Client and Completed Using Process Extensions

1. Supplier firm’s default recipient receives email naotification from buyer’'s Compliance Manager
to complete a compliance declaration.
2. Click link within notification and log into Agile PLM via Web Client (Basic mode).

3. Use the Export JGPSSI or Export AXML or Export IPC XML process extension. The declaration
request data is exported in the appropriate format, and you can open the file.

4. Enter your responses into the file, and save it.
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5.  Use Import JGPSSI or Import AXML or Import IPC XML to import the completed declaration data into
Agile PLM.

Note Be sure that you understand the value of two new fields: Alias (see Substance
Aliasing (on page 7)) and User-entered CAS Number (on page 22).

About Declaration Classes and Fields

The Declarations classes in Agile PLM were introduced in Declarations (on page 8).

More About the Declarations Classes

Following are additional facts and rules of business logic for the Declarations classes.
Part Declarations

This class of declarations is used to ask questions related to parts or part groups. The buyer
company wants to send out a questionnaire to assess part compliance with specifications from
customers and government agencies. Typical questions could be: What is the maximum re-flow
temperature of this part? What type of plating is on this part? Is this part in compliance with a
certain specification? No fields are pre-populated in this declaration.

Substance Declarations

This class of declarations allows a supplier to respond at a substance-group level and at a
substance level without being able to add to the Bill Of Substances (BOS). It could be a material
compliance declaration in which the buyer company wants you to declare compliance with
specifications at the substance level; or, it could be a partial material disclosure declaration in which
you are requested to disclose the weight and/or concentration of selected (or all) substances that
are contained within the components and subassemblies it sources from your firm (or the firm
whose products you are providing compliance information).

A substance declaration supports pre-population of substances and substance groups from
associated specifications.

Supplier Declarations of Conformance

This class of declarations requests statements from suppliers at a supplier level. It is basically a
supplier survey. The buyer company wants to send out a questionnaire and receive a declaration
from the supplier to assess compliance with specifications from customers and government
agencies. Typical questions could be: Do you have a RoHS compliance Initiative going on? When
do you anticipate to have 100% compliant Product? Which ISO certifications do you possess. No
fields are pre-populated in this declaration. The SDOC does not require association with any items,
manufacturer parts, part groups, or even specifications in order to be effective. Adding
specifications to this type of class is allowed for reference purposes.

Japanese Green Procurement Declarations

This class of declarations is used against the template for the Japanese Green Procurement format.
Agile supports only JGPSSI version 2.02. The buyer company wants suppliers to provide a

Page - 18 Agile Product Lifecycle Management



Chapter 4

declaration in the JGPSSI format using the JGPSSI supported entities. No substances from
specifications are pre-populated in this declaration.

Homogeneous Material Declarations

This class of declarations allows a supplier to build a Bill Of Substances (BOS) consisting of four
levels: subpart, homogeneous material, substance groups, and substances. It could be a material
compliance declaration at the homogeneous material level, or it could be a partial material
disclosure declaration to discover the weight and concentration of substances that are contained
within the homogeneous materials. This can be effected through an outside application or
spreadsheet. No fields are pre-populated in this declaration.

IPC 1752-1 and IPC 1752-2 Declarations

These Declarations classes support compliance work using the IPC forms for substance
declarations (IPC 1752-1) and homogeneous materials declarations (IPC 1752-2). These forms are
in Adobe PDF format. Currently (Releases 9.2.2.x), Adobe Acrobat version 7.0 is both the minimal
requirement and the recommended release for work with the IPC forms. The website for Adobe
Software is www.adobe.com.

Caution There is an issue with Adobe Acrobat 8.0 and 8.1 in which certain IPC fields (for example,
Terminal Plating/Grid Array Material) cannot be displayed. Until the problem with Acrobat
8.x is resolved, please use Acrobat 7.x with IPC forms.

IPC Formats Supported in this Release

The present Agile PLM Release supports released Version 1.1 of the IPC format. The website for
the IPC forms and information about the “1752” standards is www.ipc.org/IPC-175x.

For importing and exporting data, this matrix describes supported IPC version as related to PLM
version:

= Importing XML data into PLM 9.2.2.2—-4: IPC Versions 1.1 and 1.02 are supported.
o Importing XML data into PLM 9.2.2.1: IPC Version 1.02 is supported.

o Exporting XML data from PLM 9.2.2.2—4: IPC Version 1.1 is supported (not 1.02).
o Exporting XML data from PLM 9.2.2.1: IPC Version 1.02 is supported.

There are a few differences between Versions 1.1 and 1.02. In Version 1.1, the field "Homogeneous
Material" cannot be blank; if it is blank, it cannot be exported to an XML file.

Caution In Version 1.02, the RoHS Exemption list offers entries "10a" and "10b", but in Version
1.1, these two have been removed. So, if you import in Ver.1.02 having chosen these
values, the values are imported to the Agile system, but when you export to Ver.1.1, those
two values are no longer there.

The IPC1752-2 PDF form allows entry of unstructured substance data. For instance, the user can
enter homogenous material data in a hierarchical structure or in flat structure. With Rel. 9.2.2.1, the
system supports importing the data if it is in a proper hierarchical structure, but throws an error if the
user imports it in a flat structure. As of Rel. 9.2.2.2, the system accepts the data even if the IPC
data is in the flat structure.

In addition to the above, the system also stores the flat structure within the declaration, which can
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show the user how the data was retrieved from IPC and how Agile converted the data into a
hierarchical structure.

The storing of the flat structure is accomplished through four flex-fields, Text01--Text04, on the part
Substances tables. They are renamed as IPC Sub-item, IPC Material, IPC Category, and IPC Substance.

By default, these fields are disabled (not visible), and the flat structure is not stored. In order to
capture the flat structure of the composition, these fields must be enabled by the adminisatrator.
However, if the flexfields are enabled, but you do not have Modify privilege for them, the flat
structure is not be stored and you will get an Insufficient Privilege error during import.

In summary, if you need to see those recorded fields, see your administrator.

Guidelines for Parts and Specifications on IPC Declarations
It is required that each IPC declaration carry just one specification and just one part/part group.

There is no restriction to the number of specifications or the number of parts/PGs that can be added
to IPC declarations. However, if a declaration carries multiple items, manufacturer parts, or part
groups and multiple specifications, Export IPC XML will only export one composition from the
declaration’s <Parts/PGs> tables.

Similarly, Import IPC XML will update only one compoasition, that of the part that was exported. The
system identifies this by the part number, rev, and the first specification in the declaration’s
Specifications table, which is sorted alphabetically.

Note If you create one of the “1752” declarations and name a part/part group whose Name or
Number includes square brackets (“[" and “1”), the IPC transformation (through the Excel
integration) treats it as a manufacturer part and then it sends an error message that the
manufacturer part does not exist in the declaration. You must remove the brackets from
the part, manufacturer part, or part group’s Name or Number.

For IPC1752-1 Declarations, if the IPC form has an invalid substance with an asterisk in
its name, the imported substance’s name is truncated from the asterisk to the end (left-to-
right).

Significant Attributes in Declarations

The information supplier—user should do the following to complete a declaration.

o For each part, manufacturer part, and part group, fill in the Mass, Mass PPM, and Compliance
fields, particularly for substances that are restricted by specifications

= Add or remove substances from the Substances tables (under the Items, Manufacturer Parts, and
Part Groups tabs) on the declaration as necessary; to do this, they must use process extensions
(Export AXML and Import AXML) or the Microsoft Excel-based Client

o Complete other flex fields on the <parts/PG> tables as well as the <parts/PG> Substances tables.
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Known Issue ahout ltem Number and Manufacturer Part Number Attributes

There exists a mapping issue on the IPC forms regarding the attributes Item Number and
Manufacturer Part Number (Mfr Item Number), and also Item Name and Mfr tem Name. You may
receive a declaration and expect to see (or want to enter) data in Mfr Item Number and Mfr Item
Name. The issue is that the fields that should be used are Item Number and Item Name.

This will be fixed in a future release, until then the workaround is this: if you are having this problem,
request from your buyer company that they set a process extension that can be triggered when
moving the declaration to Open to Supplier. The process extension copies the value from Item
Number to Mfr Item Number, and from Item Name to Mfr Item Name.

This will correct all four fields on the IPC form (after exporting from PL M) to have the values
needed by both the Supplier users (in order to complete the form) and the PLM system (for
importing back to PLM).

Mass

The weight of a part (item or manufacturer part) or assembly, expressed in systemwide UOM (unit
of measure). Mass in Item Title Block, is a “rev-controlled” attribute.

Mass Disclosure

The Mass Disclosure attribute is found on the Part/PG tabs of declarations (as well as the
Composition tab of parts and part groups). It has three values: Fully Disclosed, Partially Disclosed,
and Undisclosed. The correct value is generated by the system during composition rollups.

Full Disclosure, Partial Disclosure, and No Disclosure

These are the three types of disclosure, and how they are qualified by substance compositions and
homogeneous material compositions.

= Fully Disclosed composition (Full Disclosure):

* A Substance composition is considered to be Fully Disclosed if the difference between the
part’s mass and the sum of the masses of all the substances is less than or equal to the
Mass Tolerance Percentage setting.

* A Homogeneous Material composition is Fully Disclosed if this two-step process is satisfied:
(1) The difference between a material’'s mass (that is, the immediate parent of the
substances) and the sum of mass of the substances under that material is less than or
equal to the Mass Tolerance Percentage setting; and, (2) The difference between the part’s
mass and the sum of mass of the parents of the substances should be within the Mass
Tolerance Percentage.

o Partially Disclosed composition (Partial Disclosure):

* A Substance composition is Partially Disclosed if the difference is more than the Mass
Tolerance Percentage, in which case an “Unreported” substance is added by the system to fill
in the missing mass.

* A Homogeneous Material composition is Partially Disclosed if one of the following is true:
= (1) The difference between a material’'s mass (that is, the immediate parent of the substances)

and the sum of mass of all the substances under that material is greater than the Mass Tolerance
Percentage setting; and, (2) the difference between the part’s mass and the sum of mass of the
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parents of the substances is greater than the Mass Tolerance Percentage setting; or

o The part’'s weight is missing, but none of the information is missing in the BOS tree. That is, the
Mass and PPM should not be “null” anywhere in the entire BOS tree, including subparts,
materials, or substances.

o Undisclosed composition (Non-disclosure):

* If the mass is missing for the part, substance, or the immediate parent of the substances, it
is considered an Undisclosed composition.

* Furthermore, a Homogeneous Material composition is Undisclosed if any of these cases are
true:

@ One of the substances in a material does not have Declared Mass and Declared PPM; or,
@ One of the materials does not have a Declared Mass; or,
= One of the materials does not have any substance; or,

@ One of the subparts does not have any child.
User-entered CAS Number

A value can be entered by the information supplier on a declaration or by a regular user on a part or
part group. These are used by the compliance manager to ascertain precisely what substance is
being referred to by the supplier.

Intentionally Added

Agile PLM 9.2.2 introduces the “Intentionally Added” property to act as the constraint defined in the
Joint Industry Guide and the IPC 1752 forms. If, for a substance in the specification, Disallow
Intentionally Adding is Yes, when a supplier or other user enters Yes in Intentionally Added, the
substance’s Calculated Compliance value is Non-compliant. If that substance was not intentionally
added (= No), the system can go ahead and check the Threshold PPM of the substance-for-the-
spec.

The compliance manager can modify Int.Added in the Pending status of the Default Declarations
Workflow. The supplier can modify it in the Open to Supplier status of the same workflow. It cannot be
modified in any other status (without administrator impact). If there is no value in Intentionally Added
field, the system assumes No when performing rollup calculations.

Specification

The compliance manager may inform the supplier that the buyer is going to validate the supplier's
substances based on the specifications on the Specifications tab. If there are one or more
specifications associated with this Substance Declaration (this type only), the system automatically
prepopulates the substances from those specifications for all the items, manufacturer parts, or part
groups in this declaration. If there is no specification associated with this declaration, no substance
is prepopulated, even for the substance declaration.

The specifications may concern many substances, including those not used by the parts contained
in the declaration. When a substance declaration is opened to the supplier, any substances from
the specifications are automatically added to the Substances for <Part/PG> tables. This ensures that
you are properly tracking any restricted substances contained in parts listed in the substance
declaration.
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Specification Intentionally Added

In parts/part groups and declarations, the Substances tables also have an attribute called Spec
Intentionally Added. This property points to, on the substance’s Specifications > Substances tab, the
value of attribute Disallow Intentionally Adding. This read-through attribute is readable and
searchable but cannot be modified. For existing customers who do not have an Intentionally Added
flag in the Specifications > Substances tab, the system assumes that it is set to No.

Exemption

There is an Exemption field on a declaration’s <Parts/PGs> tabs. Exemptions are set in a
specification’s General Info page; the values you see for Exemption on a declaration’s Parts tab are
really coming from the associated specification.

For this reason, Declared Compliance is valid only if there is an associated specification in the
declaration. Only when there is a specification, and the spec has exemptions associated (found in
the spec’s General Info), can you set Declared Compliance to Exempt: when you do, you are then
prompted to select an exemption from the list.

Declared Compliance

This field allows an information supplier to simply declare the compliance state of the substance,
either Compliant or Non-Compliant.

Threshold Mass PPM

“PPM” means Parts Per Million. The Threshold Mass PPM value comes from the Threshold Mass
PPM for the corresponding substance in the specification. If enabled, it can be used by the supplier
to declare the mass at each level of the BOS.

Declared PPM

If enabled, can be used by the supplier to enter the PPM values directly; can be used by the
supplier to declare the mass at each level of the BOS. It supersedes the Calculated PPM in the rest
of the rollups.

Calculated PPM

The PPM as the result of the division of the mass of two levels.

Substance Editing

Substance editing lets you add, remove, and edit substances directly in (unpublished) declarations.
The substance editing feature is available on all types of declaration except Supplier Declaration of
Conformance and Part Declaration.

Linked to Composition Type Field, the declaration classes in which substance editing works are as
follows.

@ Composition Type = Substance Composition:
®  Substance, JGPSSI, and IPC 1752-1 declarations

Page - 23



Product Governance & Compliance Supplier Guide

= Composition Type = Homogeneous Material Composition:
®  Homogeneous Material and IPC 1752-2 declarations

The behavior of the four new Actions are described according to the type of declaration.

Substance Type Declarations: Substance, JGPSSI, and IPC 1752-1 Declarations

Add -- lets you add a substance group or a substance to the selected part. You can use search, or type
in known substance names directly; "Type-in names" is also the method to add a non-existing
substance. The system will prompt if you add a duplicate substance to the same part. When you
add a substance group, the system does not populate its children. In the Substance type of
declarations, you cannot add a material or subpart directly to the part.

Note If a substance/substance group added (using typed-in names) does not exist in the
system, a question mark ("?") appears in the substance name indicating this is an invalid
substance. You can use Verify Substances to make the correction.

Add Sub-level -- lets you add a substance to a selected substance group (SG). If you do not select an
SG (or you select a substance instead), the system prompts you to select a valid row. You can type
in known substance names to add an existing or non-existing substance to the parent SG.

Edit -- lets you edit all editable fields on selected rows. Note that you cannot edit the name of the
substance itself.

Remove -- lets you remove selected rows from the part. If the selected row is a substance group, the
system removes all substances under that substance group.

The system will block any attempts to add the "Unreported (System)" substance.
Homogeneous Material Type Declarations: Homogeneous Material and IPC 1752-2 Declarations

Add -- lets you add a subpart or a material to the selected part. You can use search, or type in known
subpart/material names directly; "type-in names" is also the method to add a non-existing
subpart/material. The system will prompt if you add a duplicate subpart/material to the same part. In
the Homogeneous Material type of declarations, you cannot add a substance or substance group
directly to the part.

Add Sub-level -- lets you add a substance to a selected SG, a substance or SG to a material, or a
subpart or material to a subpart.

Edit -- lets you edit all editable fields on selected rows. Note that you cannot edit the name of the
substance itself.

Remove -- lets you remove selected rows from the part. If the selected row is a parent (subpart or
material or a substance group), the system removes the entire hierarchy under that parent.

The system will block any attempts to add the "Unreported (System)" substance.

Importing and Exporting Declarations

“Process extension” is the formal name of items in the Actions menu in declarations (in standard
Web Client) or links in the Actions column of declaration rows (in simplified Web Client). Links in the
Actions column enable you to perform an operation directly without having to go open the
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declaration itself.

Note Any kind of declaration can use “Open in Excel” as long as an Excel template for
that declaration class has been created. Consult with your buyer firm and the
Oracle Consulting — Agile Practice representative. Also see Working with
Microsoft Excel-based Client (on page 27).

These are the current process extensions that may be available on declarations. The Agile
administrator at the buyer firm may have elected not to use more than the basic Actions found on
most Agile objects.

Process Extensions for JGPSSI Declarations

The following process extensions apply to JGPSSI declarations:

= Open In Excel — This process extension activates the Microsoft Excel-based Client and opens
the JGPSSI template in Excel

= Import JGPSSI — This process extension imports data from a text file in JGP Block format for
integration with the JGPSSI Excel template

o Export JGPSSI — This process extension exports data to a text file in JGP Block format for
integration with the JGPSSI Excel template
Process Extensions for Part, Substance, and Homogeneous Material Declarations

The following process extensions apply to Homogeneous Material Declarations, Part Declarations,
and Substance Declarations:

o Import AXML — “AXML" is Agile XML, an XML representation of Agile's business schema that
contains all product content managed in Agile. You use this process extension to export the
declaration information in aXML format. The declaration can be completed and re-imported into
PLM.

o Export AXML — A declaration that was exported using the aXML format and then completed can
be imported back into PLM using this process extension

Process Extensions for IPC Declarations

The following process extensions apply to IPC declarations:
o Import IPC XML — Imports XML data that is used to complete IPC forms
= Export IPC XML — Exports XML data that is used to complete IPC forms

Note It is possible that when you submit data to Agile from Microsoft Excel-based
Client, the data may not be successfully imported at the buyer side. Yet you
may have received a notification indicating that transmission of the data was
successful. The notification is triggered by your submitting the data, not by its
successful receipt: the compliance manager may ask you to re-submit the data
in these cases.

Exporting PG&C Data

Grouping the possible “export” process extensions:
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o JGPSSI declarations use Open in Excel to open the contents of the declaration’s Parts tab in the
JGPSSI format

o Export JGPSSI exports the declaration in JGP Blocks format

o Export AXML exports the declaration in aXML format; this can be used with Part Declarations,
Substance Declarations, and Homogeneous Material Declarations

o Export IPC XML exports the declaration in XML format that is used to complete IPC forms.
Importing PG&C Data

Grouping the possible “import” process extensions:

= Import JGPSSI imports a JGP Blocks file (if it was exported via Export JGPSSI) back into the
declaration

o Import AXML imports an aXML file (if it was exported via Export AXML) back into the declaration

= Import IPC XML imports an XML file (if it was exported via Export IPC XML) back into the
declaration.

Importing and Exporting IPC Declarations

This task outlines how you might receive an IPC declaration that was created in Agile at the buyer
site. You would complete the declaration working in the IPC PDF.

A typical RFI sequence with an IPC declaration:

1. The compliance manager at the buyer site creates an IPC declaration in Agile PLM; this is an
instance from one of Agile’s IPC business classes, IPC 1752-1 Declarations or IPC 1752-2
Declarations. The default workflow for the declaration is moved to the Open to Supplier status.

2. You, the declaration recipient at the information supplier, log in to Web Client (Basic mode) and
see the declaration name. A link in the declaration row activates the Export IPC XML process
extension. (Or, if you click the declaration name, all available process extensions are displayed
as links on the left navigation pane.) An XML file is saved on your machine.

3. If you have already downloaded the IPC PDF forms from the IPC web site (www.ipc.org/IPC-
175x), open the IPC form in Adobe Acrobat and click Import Data (or File > Form Data > Import Data
to Form), then specify the location of the XML file. The XML-contained data is imported to the
PDF form.

4. Enter or modify values in the declaration.

When you have completed the form, the data is exported using Export Data (or File > Form Data >
Export Data from Form). The existing XML file is overwritten.

6. Returning to Web Client, use Import IPC XML process extension to import the modified XML
data. Then submit the declaration to the buyer firm.

7. Atthe buyer site, the compliance manager opens the completed declaration in Agile to review
for possible release.
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Working with Microsoft Excel-based Client

The Microsoft Excel-based Client should be installed, configured, and tested by the buyer company.
If you have problems with the Excel integration in PG&C, contact the compliance manager at the
buyer company.

When you first access a declaration via the Microsoft Excel-based Client, a folder is automatically
created on your desktop to store declarations. The folder may be called Agile Spreadsheet Files.
Although you must access the Client via Agile Web Client the first time, you can subsequently open
Microsoft Excel and access declarations directly.

You may receive a test (JGPSSI) declaration from your buyer company, and you can use the
following task to test whether the Microsoft Excel-based Client for JGPSSI Declarations is working

properly.

To test JGPSSI Declarations in Microsoft Excel:

1. Loginto Agile Web Client.

2. Click the link to the JGPSSI Declaration to open it.
3. Click Open In Excel; it is in the Actions column.
4

Microsoft Excel is launched and the file is opened. You are prompted to save the file to a folder
on your desktop.

Fill in a one or more fields on the sheet. For example, change the value of the Parts Mass field.
Save the Microsoft Excel file.

On the Agile menu in the Excel client, choose Submit Response. The Submit Response window
appears. You are prompted to log in when attempting to submit response from Agile menu in
Excel.

8. Type your approval password, and click Submit.

Wait while your response is uploaded. After a minute, a message box should appear: “Your
response was successfully submitted for processing.” Click OK.

Note When you open a JGPSSI declaration in Microsoft Excel and try to edit one of
the cells, you may see the following error message: “The cell or chart you are
trying to change is protected and therefore read-only. To modify a protected
cell or chart, first remove protection using the Unprotect Sheet command
(Tools menu, Protection submenu). You may be prompted for a password.”
However, the colored cells of the JGPSSI template (such as headings) are
protected and cannot be edited. You should edit only unshaded (white) cells.

Note After submit from Excel Integration, it can seem that supplier data has been
submitted and declaration has moved to next status, whereas the server takes
awhile to process the data.

Notes on Excel-based Declaration Submissions

When the supplier has used the Microsoft Excel-based Client to submit the declaration, it is possible
that data may not be successfully imported to the buyer side. There are two stages in which their
data is processed. The data is uploaded to the server; upon successful upload, the supplier
receives the message that “Your data has been submitted for processing.” The data is then be
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processed on the server and imported into the system.

If there was a problem with the upload, the supplier is notified immediately; but if the problem
occurs at processing or importing on the server side, the system sends an email with the error log
as an attachment to the supplier. This means that the declaration remains in Open to Supplier
status, and this does not change until the supplier reviews the log in the email notification, makes
appropriate changes, and re-submits.

Even if the import on the server side is successful, depending on the size of the declaration, it will
take some time for the declaration to move from Open to Supplier to Submitted to Compliance
Manager. So if the user checked the declaration immediately after submitting from Excel, they may
not see the changes for awhile.
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